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FLIR Tools +

Advanced PC software for creating Microsoft Word templates
and reports, panoramas, and sequence recordings.
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it i What is FLIR Tools?

FLIR Tools is a versatile software suite for importing
and analyzing images and creating inspection
reports.

» Import images, videos, and CSQ files from FLIR cameras.
+ Analyze IR images and save changes.

+ Adjust object parameters globally and locally.

« Create text annotation templates.

« Create and save inspection reports and export to PDF.

* View live radiometric video and save JPEGs.

» Play and analyze SEQ and CSQ files.

» Create temporal plots from measurement results.
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it i What is FLIR Tools+?

The FLIR Tools+ License Adds:

» Panorama stitching.

« SEQ recording (real-time and interval) and
playback.

» Word Reporting using the FLIR add-in.
» Create custom templates and Word reports.

« Save documents for post-processing at a
later time as a Word document.
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it Qi Install FLIR Tools

e

— Type support.flir.com into

T
| € supportflir.com

the address bar and press
x Google | Press Alt+G to search Enter.
You will need an account to
Hom | [ Answers .|| Ask a Question | Product Registration. | Dovnloads download the software.

' Download Software

Navigate to Downloads,

Software - Available freeware and downloads. Software, and then select
e Select a product from the_ list boxes bel(_)w. » ] TOOIS from Compllter
: g“%:r;;:g :E:;c;?:gi?n!:::e?nder the list boxes to begin downloadir Software (Thermography).

R 4 0)
(EEIECH| Click to subscribe to our RSS feed ¥4

Note: Windows XP users must
Click here for the 10 most recently uploaded downloads.

use version 4.1.
Product /\ /

[Computer Software (Thermography)
Tools V.

FLIR Tools for Mac OSX
FLIR Tools / FLIR Tools+ 4.1 for Windows XP
FLIR Tools / FLIR Tools+ 5.x

FLIR Tools can be downloaded from the FLIR Support Center website. A user
account is needed to download software and manuals.
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@a"mz FLIR Tools + Activation
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* Incorporated in the same download as FLIR
Tools.

* To enable the features a purchased licensed is
required, or a 30 day trial can be used to
temporarily activate the software.

* The Word Add-in requires a 32-bit edition of MS-

Office 2007, 2010, or 2013.

« If using Office 365 Word must be installed locally on the
PC. The “cloud-only” version does not support add-ins.

6/29/2015
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it Activate FLIR Tools+

% . Activation of FLIR Tools+ B

User's Manual

@ I have a Serial Number and I want to activate FLIR Tools+

Product registration...

License options...

Check for updates... Enter your Serial Number to activate FLIR Tools+.

About

You don't have a Serial Number?

I want to evaluate FLIR Tools+ (there are 30 day(s) left to
evaluate)

You can evakiate FLIR Tools+ for another 30 day(s). After that you have to activate FLIR Todls+ to further
use the product.

In FLIR Tools click Help,
License Options and click
Apply on the window that

appears.

Restart FLIR Tools and
choose the Serial Number
option and click Next. ot

FLIR Tools+ can be activated from FLIR Tools, no additional software needs to
be downloaded. From FLIR Tools click Help, License Options, and click
Apply. Now close and re-start FLIR Tools. A new window will appear with two
options:

1. If you have a serial number select the option “| have a Serial Number...."
and click Next to activate online.

2. If you want to try for 30-days chose the “I want to evaluate...” option and
click Next. This is a fully functional version of FLIR Tools+ that will expire in 30-
days unless activated.
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@ Objectives

Create a Panorama image.
Record sequences.

Create a new Microsoft Word template:
+ Page layout tips that will help with the design process.

» Use FLIR Tools+ objects such as the IR and DC
Viewer, Tables, and Fields.

+ Add a Cover Page and Summary Page.
Send selected images to a new Word report.
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@ Panorama

Using the Panorama tool, images
can be combined into a higher
resolution JPEG image.

Panorama images can be edited
and used to create PDF and Word
reports.

The Panorama Tool allows you to combine several radiometric JPEG images
into a single, high-resolution JPEG image. The resulting image can be saved
and used in FLIR Tools reports (REPX) and Microsoft Word reports.
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@ Panorama

W Add ) Import

To create the Panorama image(s),
select all the images you wish to
combine. Then, right-click and
click Combine into Panorama.

C I eic

10items (10 selected)

The process of creating the Panorama image starts in the Image Library. First,
find and select the images you wish to combine. You can use the CTRL key or
SHIFT key on the keyboard to select multiple images. Right-click on one of the
selected images and click Combine into Panorama.
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@ Panorama

In this case four Panoramas were
created from the selected images.
You can click on each combined
image from here to view and edit
the image.

The software will automatically detect matching images and combine them into
a Panorama. If multiple Panorama’s exist, the software will sort out which
images go together and create more than one image. In this example four
Panorama images were created from the selected images.

10
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@ Panorama

These two buttons can be
used to crop the image
and to make perspective
corrections.

; s | h!!-;' g T

IR_0126,jpg IR_0130.jpg IR_0131,jpg

Panorama images can be cropped to remove some of the jagged edges that
can occur. Some perspective adjustments can also be made.

11
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@ Panorama

@ FUR Tools«

Click on the arrow button
to save the combined

image to your Image
Library.

The arrow button can be used to save the panorama image to the library.

12
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@ Panorama

Since the Panorama image is radiometric you can open it
from the Image Library, measure temperatures, save
changes, and send the image to a report.

Panorama images created using Tools+ retain all of the temperature
information, allowing you to process the images, measure temperatures and
create inspection reports.

13
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Panorama

If MSX images are combined the Fusion functionality is
retained, and you can switch between the various Fusion
modes from the toolbar.

6/29/2015
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@ Sequence Recording

@ FLR Tools+ =SR]

Any cameras that are
currently connected are
shown in the
Instruments list.

Click on the lightning bolt
to display a live image
from the camera.

FLIR Tools+ can record radiometric sequences from compatible USB and
Ethernet cameras. You can also control the focus, change range, and measure
temperatures on the live image. Any cameras that are currently connected can
be seen in the Instruments list.

Click the lightning bolt button to display a live image.

15
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@zzm@wﬁ Sequence Recording

Use these buttons to adjust
focus (for cameras that have
motorized focus capabilities)

and NUC.

¥ Camera capture

e © @® \
) Set the measurement range,
frame rate, and recording speed.
The recording speed matches the
frame rate unless the ‘time
interval’ box is checked.

N
This shows the longest recording

possible, depending on available disk
space and recording speed.

Most of the camera control functions are the same as with FLIR Tools. If the
camera has electronic focus you can adjust the near/far focus, and you can
auto-focus. You can also perform a NUC, which is a good idea before a
recording is started.

The measurement range can be changed, the range limits depend on the
camera model. You can also adjust the frame rate for certain cameras.

By default the recording will be at the selected frame rate, however this can be
reduced using the ‘time interval’ checkbox. For example, you can choose to
record one image every second. This can save disk space in cases where the
highest frame rate is not needed. The total duration of the recording (based on
available disk space and recording speed) is shown at the bottom of the
window.

16
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@w;msg Sequence Recording

Options

File saving options.
File name prefoc  MyRecord

Image format: FUR JPEG (*Jpg)
Video format: FLIR Sequence (*.seq)

Disk space (C:)
Maximum amount of disk usage: ~

1415 GB of 1489 GB disk

| C

|

| £
Recording

The Gear button allows you to \
name the recording and choose the
location for the recording.

You can also set the maximum
amount of disk space used by FLIR
Tools+ for recordings. J

The gear button allows you to set the name of the recording and also select a
location. The default location is \My Documents\FLIR\Recordings.

17
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@ Sequence Recording

The Pause button mcan be used to
freeze the live image. The Camera
button [[ZJ] can store a radiometric

JPEG image to disk.

¥ Camera capture

S fen e

o To begin recording, click the red

Record button [l
This turns into a Stop button [ that
can be used to stop the recording.

)

New recordings will appear in the
Filmstrip below. You can double-
click to edit a sequence.

N

The record button is enabled with Tools+. This begins the recording at the
selected frame rate or time interval. This turns into a stop button which can be
used to stop the recording.

18
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@2 Play and Analyze SEQ and CSQ Files

SEQ and CSQ recordings are radiometric. This
allows you to measure temperatures and make the
same adjustments you can make with a JPEG
image imported from a FLIR camera.

781°F

00:00:13:667 / 00:00:50:233

Once the SEQ is recorded to disk you can double-click on it to open the video.
FLIR Tools and Tools+ can process SEQ and CSQ recordings.

As with any standard radiometric JPEG, you can easily measure temperatures,
adjust the thermal tuning, change emissivity and other parameters, and add
text annotations to the sequence. All of these changes can be saved with the
recording.

19
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@2 Play and Analyze SEQ and CSQ Files

Using these buttons you can The time stamp
replay the sequence at the and other image
Playback speed set speed, and you can data can be seen
can be adjusted move forward/backward by in this area.
here. one frame.

4 » 00:00:13:667 / 00:00:50:233

< wm > | seve W soveondciose Ml Concel |

20

If you click the x1 button the playback speed can be adjusted to play forward
or backward up to 60x times the original speed. The play buttons in the center
of the toolbar will play the recording, and you can step forward/backward by
one frame. The camera type, date, time, and other data shows in the panel to

the right of the image.

20
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@2 Play and Analyze SEQ and CSQ Files

The Camera button E allows
you to save the current frame to
your image library as a JPEG.

The Clipboard button Bcan
convert the sequence to an AVI
file.

The Loop button[E]will replay
the sequence automatically.

! 781°F
—1i
m - c x1 4l > 13 00:00:13:667 / 00:00:50:233
ul I ) — |
< 3 > | ssve W ssveandciose Wl Concel ]

21

The camera button below the image allows you to extract any frame from the
recording to your image library as a radiometric JPEG. This can be analyzed
using FLIR Tools and can be used in a report.

You can also convert the sequence to an AVI file, which is handy for sharing
with others who do not have the FLIR software.

The loop button will automatically replay the sequence.

6/29/2015
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@ Play and Analyze SEQ and CSQ Files

TRAINING
- Temporal Plot

Local max/s

To create a Temporal Plot,
right-click on a ——
measurement tool, select Delete
the Plot menu, and click on ;"
the item you wish to plot.

Local parameters.

The graph is drawn for
the sequence without
having to play it.

22

Temporal Plots can be a convenient way to analyze transient events.

Plots can be created using any measurement tool. Just right-click on the tool,
click Plot, and then click the item you wish to plot. In this case we are plotting
the maximum temperature of Area 1. The graph is drawn automatically without
having to replay the entire sequence.

22
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CENTER - Temporal Plot

@ Play and Analyze SEQ and CSQ Files

In this example we are
plotting the maximum
temperature of three
different areas on the
same graph.

23

More than one tool can be plotted on the same graph. To add more tools
simply right-click on the next tool and choose the Plot menu again. Repeat this
process for each tool you wish to plot.

This graph is plotting the maximum temperature of three different areas.

23
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@ Play and Analyze SEQ and CSQ Files

TRAINING
- Temporal Plot

You can right-click on the plot,
click Copy, and click Data to
send the plot data to the
Clipboard and paste into Excel.

Plot 1 PCBoard2013-02-11T131414861.seq

Show whole plot

Plotting Method »

Qotions
Copy

% Delete

| copl Plot readings to clipboard

12

13 Date Time Milliseconds Relative time Arl.Max. Ar3.Max. Ar2.Max.

14 2/11/2013 1:14:14 PM 433 0 84.64529 81.2286 82.02937

15 2/11/2013 1:14:14 PM 433 0 84.6184 81.183 81.9567

16 2/11/2013 1:14:14PM 466 0.033 84.6632 B81.17388 82.07476

17 2/11/2013 1:14:14PM 500 0.067 84.62736 81.14651 §2.03844 Excel shows detailed
18 2/11/2013 1:14:14PM 533 0.1 84.62736 81.08265 82.03844 information about each

plot point.

24

Plot data can be easily copied from FLIR Tools as text and pasted into other
programs like Microsoft Excel for more detailed analysis.

Just right-click anywhere on the graph, click Copy, and click Data to copy the
plot data to the Windows Clipboard. Now you can start Excel and paste the
data into a new spreadsheet.

Each row represents a plot point in the graph. The data is broken up into
columns showing the date, time, and temperature for each measurement tool.

6/29/2015
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it Export CSV Data

You can right-click
anywhere on the image et
to Export to CSV. il From the pop-up
S window you can
choose to export the
entire image, or
specific

Export to CSV.

Color distribution

Plot , g 1 i measurement tools.

25

Temperature data for an image, or for any measurement tool, can be exported
to CSV format. This is a comma-separated text file that can be read using
Excel.

25
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Export CSV Data

A B c D E F G H 1 J K L M N o 5
1 [File: lc:\Trammg\Good Images (06-10-2015)\SEQ\PCBoard2013-02-11T131414861.seq
2
3 Bxl
4
5 Framel \\_79.847 79.865 79.884 79.874 79.911 79.874 79.893  79.838 79.856 ||
6 7 79.893  79.893  79.828 79.792
7 79.828  79.856  79.819 70856 |
8 79.856  79.838  79.737 79.81 |
9 79.773  79.856  79.865 79.828 ||
10 79.893  79.819  79.737 X 79.865 ||
1 When exporting from 79.994  79.893  79.929 Each cell in the 79.911
12 79.957 79.985  80.003 spreadsheet 79.911
13 an SEQ or CSQ, the 80.003  79.985  80.003 p X | 80.067 i
14 : . 80.021  80.067  80.095 represents a single 80.049
T frame differentiator T BT P el 9 = |
16 appears in column A. 79.966  79.957  80.003 p % 79.92
17 79.939  79.975  79.957 79.847
18 . 79.966 80.012 7992 79.957 79.902 79.856 79.819  79.81  79.746
19 79.929 79.929 79.957 79.975 79.948 79.948 79.966 79.966 79.966 79.939  79.838  79.433  79.608  79.792
20 79.939  79.975 79.948 79.975 79.966 79.948 79.893 79.975 79.874 79.957  79.81 79.507  79.92  79.663

[ 21 79.939  79.893  79.939 80.003 80.003 79.957 79.985  79.92 79.929 79.865 79.746 79.874  80.003  79.975
2 79.948  79.939  79.92 79.948 79.911  79.92 79.939 79.994 79.929 79.957 79.975 80.012 79.975  80.012
23 79.865 79.884  80.067 79.975 79.939 79.929 79.966 79.929 79.874 79.994 80.012 80.012 80.021  80.049
24 79.929 79.985 79.994 80.003 80.104 80.104 79.948 80.058 79.939 79.985 80.058 80.076  80.058  80.067
25 79 994 79994 |Nna /003 /0 NSS 79 994 79 966 79 985, 2003 004 RN NR7 !N 104 !N NS ann3 ¥
M <> M| exportl %3 []< (20
Ready 5@ 100% (= +

26

When exporting an image, area, or line, the text file will contain an array of
temperatures for each pixel.

When exporting from an SEQ or CSQ, each frame from the recording is
exported to a single CSV file. Column A contains the frame differentiator.

6/29/2015
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FLIR Tools+
The MS Word Add-In

27

The Microsoft Word add-in expands the reporting capabilities by allowing you to
create custom Word templates.

27




FLIR Tools+ User Guide

@ e Tools+ Add-In

Use the Word Tools+ Add-In to automate the

report generation and:

« Conduct the Same analysis on each image
in the report.

» Use a consistent color palette through out
the report.

« Multiple Logos.

» “Customize” the report with customer
specific information from the same
template.

6/29/2015
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@ Tools+ Add-In

» Use formulas for complex analysis such as
severity determination.

« Automatically generate a summary table of
the “findings” within the report.

* Create “fused” images (PnP, Fusion, MSX)
from individual Infrared and Visual (Digital)
sources.

29
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@ Sample Template Design

[Coverpage }- ]

T ‘ Summary Page F

[Company] Thermography Repart Summary

4§
i

Inspection Date: [Date]
Thermographer: [Thermographer]

Report Description

30

This tutorial will guide you through the process of designing a new template
consisting of:

A page with an IR and Photo placeholder.

A page with a Summary table.
A cover page with Document Properties.

30
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Tools+ Add-In

/ l:": (=] LK
a
Home Insert
I E IR Profile

- |& IR Histogram
IR  Digital
Viewer Photo [ IR Trending

Page Layout

[#] Quick Insert

3 c

References

Documentl - Microsoft Word

Mailings

2 Field [&F Delete Page

o .\'Nord 2007

Review

View

te Page

[ Report properties

Developer FLIR Tool

Help FLIR

EI D L& IR Profile
- i

IR Histogram

[ Quick Insert & Field

¥

Tabl

Images and graphs Document FLIR Tools + (Days left: 30)
Home Insert Page Layout References Mailings Review View Developer | FLIR Tools+ |

E.?f Delete Page
[=h) Duplicate Page

E_.]Report properties @ c

EI u EE IR Profile
- "

o IR Histogram
IR Digital

Viewer Photo =2 IR Trending
Images and graphs

[# Quick Insert

4

@ Delete Page
[=l] Duplicate Page

Word 2013

IR Digital Help FUR
Viewer Photo & IR Trending WOI’d 201 0 v N
Images and graphs =0 Document FLIR Tools=
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW VIEW | FLIR Tools+ I

E Report properties @ c

Document

Help  FLIR

FLIR Tools+

31

The FLIR Tools+ add-in appears as a tab in Microsoft Word. This tab is always

present in Word unless you uninstall or de-activate Tools+.

6/29/2015
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Set Page Layout

Set Page Margins Set Orientation

sert Page Layout References Mailin sert Page Layout Refer|

ML RbE it N "E" N

Margins|PDrientation Size Columns Margingj Orientation]] Size C

be™ Hyph

Last Custom Setting
Top:  1” Bottom: 0.5° [ j Portrait
left: 1 Right: 1" ‘

Normal Landscape

Top: 1 Bottom: 1°

Set Paper Size

sert Page Layout References Mailings

53 lj | ¥=) Breaks ~
L=) ¥ ) Line Number|

Margins Orientationg Size |Columns

be~ Hyphenatior|

Letter -

| [resoxas:
117
_} 117 x17°

Legal
_I 8.5 x14"

left: 1 Right: 1

Narow

Top: 0.5" Bottom: 0.57

Left: 0.5 Right: 0.5

Moderate Home Insert Page Layout

Top: 17 Bottom: 1

Left 075 Right: .75 N j elal
— A ] (=== HBE)

Cover | Blank Page

Table Picture Clip
~| Page  Break \/

Art

Page Tables

Navigaﬁ Blank Page

n| Insert a new blank page at the
% cursor position

0 Press F1 for more help.

Insert a Blank Page or
use Page Breaks to add
new blank pages to the

template.

32

It is best to set the page layout, size and margins before beginning the design
process. If you need to insert extra pages insert a blank page, or insert a page

break.

6/29/2015
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itz Use the Word Header and Footer

. Infrared Training Center
INFRARED
®m.~mc = You can insert any 25 Esquire Road

CENTER & Billerica, MA 01862, USA
" standard picture as henoogrghe]
your logo.

Header

J

Double-click at the Top or Bottom of the
Page to Edit the Header or Footer.

Footer
Page3of3 10/2/2008

33

The Word header and footer are ideal for displaying information that you would
like to show on all pages. By utilizing the header and footer space you reserve
more page space for IR data, tables, and text boxes.

33
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Use the Word Header and Footer
- Different First Page

Change the Page
Layout to use a different
Header and Footer for
the cover page.

Mailings Revi|

Insert | Page Layout I References
5 lj '—“ Breaks ~

¥ Line Numbers ~
Margins Orientation Size Columns ~
= v - - be~ Hyphenation ~

Page Setup

e e [ |

Section

Click here to show

the Page Setup —
dialog box.

Secton stat: New page -

Headers and footers
Different odd and even
| Different first page

Header: 0.5
From edge:
Footer: 0.5
Page
Vertcal signment: | Top -

Click the Different
First Page
checkbox on the
Layout tab.

Preview

Aoplyto: | Whale document []

Set As Defaut

34

If needed you can alter the page layout to display a different header and footer

on the cover page.

6/29/2015
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@'g"g?ﬁiﬁg Use Word Tables to Help with Page Layout

Date 9/30/2009
Image Time 6:07:49 PM
Max Temperature 70.0°C
Emissivity 1.00

Insert a New Word Table

Home Insert Page Layout References

] = j |} _jﬁ ’;.|" 4

L) |
Blank Page | | Table || Picture Clip Shapes Sma
Page Break - Art -

Pages 2x1 Table 3.9

mEEfEfaiis

|
ogoo
ooad
] ]
0ooo
Oood
Ol
0o
2 Insert Table..
4 DrawTable

Example 1: IR Next to a Result Table

Ooo0o0
0oooog
8
o
o
000000
Ooooog
0ooooo

0

Excel Spreadsheet

El &l (-

Quick Tables >

Example 2; IR Next to a Photo

35

When adding items to a Word page it is good practice to insert them into Word
tables. This allows you to easily place an IR Viewer next to a photo or a Result
Table.

6/29/2015
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@ e Insert an IR and Photo Box

Add a placeholder for an IR image and digital photo. Remember to add a
Word table to the page first. Then insert the IR objects inside the table.

n Home Insert Page Layout References Mailings Review

View Developer FLIR Tools+

ﬂ I E £ IR Profile [# Quick Insert ’5-‘ Field ;7} Delete Page E%Report properties @ c
- |l IR Histogram [ ] Table @ Duplicate Page
IR Digital

Viewer Photo | IR Trending

Help  FUR
E] summary Table - =
and graphs Tables

Click the mouse in
the table cell and
click the IR Viewer
button.

Click the mouse in

the table cell and click

the Digital Photo
button.

.

36

Add a Word table to the page with 1 row and 2 columns. Insert the IR Viewer
into the first column, then insert the Digital Photo into the second column. You
can resize either box by clicking and dragging the corners.

36
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it Qi Set Temperature and Distance Units

If you set your preferred units in the template then you will not need
to change them for each report.

Home  Inset  Pagelayout  References  Mailings  Review  View  Developer | FLIR Tools~ J
ml K& IR Profile [# QuickInsert & Field Fg} Delete Page [}l Report properties @ °
- | IR Histogram (& {3 Table (&) Duplicate Page
IR Digital

Viewer Photo & IRTrending (%] Summary Table

and graphs Tables Document
e = Create a report template

Set units...

Selected language..

Click FLIR, then
Set units

About...

Select Units

Temperature Di

37

Since the temperature and distance units are typically the same for all reports it
is best to set them in the template. You can always change them in the report if
needed.

6/29/2015
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it Set IR Preferences

Use the IR Preferences tab to pre-define measurement tools, color palette,
and temperature scale settings for your template. These settings define the
default behavior for your template.

v ShowIR Scale

Click the

Zoom »

’ Preferences
WET— Tab.

Rotate Right
Rotate Left

Right-click on the
IR viewer and
click Settings.

Formulas...

38

You can pre-define measurement tools in the template if you would like them to
appear on all reports (e.g.: a spot meter and area box). You can pre-define
other settings such as the color palette and scale limits.

6/29/2015
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@2 Add Pre-Defined Measurement Tools

Measurement Tools can be pre-defined in your template. This example shows
a Spotmeter, Area box, and Delta T. Note that you must have “Pre-defined
measurement symbols...” checked in the IR Preferences.

k&]l*‘r nloa/wgo B ~Q -~k

Single-click on the
Ari:max 158.0 i IR viewer box to

display the
‘ Measurement
i Iy Toolbar.

— A

39

If you click on the IR Viewer box the Measurement Toolbar will appear, allowing
you to select from a variety of measurement tools.

6/29/2015
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it Customize Measurement Tools

Measurement tools parameters can be customized. For example, you can change
the label from “Sp1” to something more descriptive, like “Reference Temp” or “Max
Temp”.

158.0 °F
L 150 Type a new

label.

D =\ : =
LIR B —
y _ Show the

Arl:max 158.0

temperature
on the image.

r S0

Right-click on a

measurement Change tool
| image. b | tool and click and label
Settings. o] | colors.

40

You can override the generic tool label and color for any measurement tool
once it is placed on the IR Viewer. This can be done in the template and in the
report.
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INFRARED

@zmwc Add Text Annotation Labels

Text Annotations can be used to annotate each IR image with text labels and
values.

Click the
Annotations
Tab.

Temp. Risc

Image Fusion...

Rotate Right
Rotate Left

Right-click on the
IR viewer and
click Settings.

Formulas...

Click the Add
button to add a
new label.

(o | concel J—mmmr—g—we—

41

Text Annotation labels can be pre-defined in the template, as a formal way to
“tag” the IR images with certain information. This data can be displayed using
the IR tables and fields, including the Summary table.

If the same labels are used in a Text Annotation Template, the values will auto-
populate the fields when the report is created.

Another advantage of pre-defining the labels is that they become available for
use in the Summary Table.
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CENTER

@;N.:msg Add a Result Table

A Result Table can be added to the page to display image information such as
date, time, text annotations, and temperature measurements.

Home Insert Page Layout References Mailings Review View Developer FLIR Tools+
ﬁ' Q E 1R Profile [# QuickInsert & Field [a¥ Delete Page I.T‘-'g Report properties @ c
- Il IR Histogram (@ [=h) Duplicate Page
IR Digital Help  FLR
Viewer Photo <~ IR Trending j:l Summary Table - -
Images and graphs Tables Document FLIR Tools+
-
= || I

9/30/2009 pate 9/30/2009
Filename
158.0°F Max Temperature | 158.0°F
\ Min Temperature | 39.0°F

Click the mouse in

the Word table cell

and click the Table
button.

A Result Table will be added to
the page with some default
values.

42

A Result Table is a special FLIR table that links to the IR Viewer on the page. It
is always two columns wide, the number of rows depends on the user settings

(see next step).

6/29/2015
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@ Add a Result Table

Result Tables can be easily customized in the template to display specific
information related to your reports.

] | Image Description | -
Location

Date 9/30/2009
Image Time 6:41:11 PM
Max Temperature 158.0 °F R
Emissivity

| Arl Max. Temperature
Ref T Borders and Shading...

Spelliog

Ten

Check the items
you want to display.

E Delete the

_ B .
e items you

want to
remove.

To customize the
table right-click and
select Contents.

43

The Table Contents window is divided into two sections; the Objects are the
categories, the Values are associated with the selected Object. Simply check
the items that you want to display to add them to the table.
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@ Add a Field

AField can be used to show a single IR parameter anywhere on the page.

Home Insert Page Layout References Mailings Review View Developer FUR Tools+

?“ D &5 IR Profile [# Quick Inse B} Delete Page I:'lﬂ Report properties @ °

I IR Histogram = 1able [a] Duplicate Page

B ey (REEEE—
Field Contents Choose to show or
: hide the label.
Click the o

Field button. i )
~

Select the item

from the list and

click OK.
J
[ o |

44

A Field can be used to show a single IR value on the page.
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it Add a Summary Table

A Summary Table is typically added to a front or back page and can be used
as a table of contents, or as an inspection summary.

Insert Page Layout References Mailings Review View Developer FUR Tools+

Cllck the bfile [# Quick Insert EP— Field @ Delete Page E‘L Report properties 9 c
t ) Tabl (&} puplicate P
Summary Table [ e B upliale oae Help  FUR
i =

Summary Table

Click OK to add
the table to the

page.

Click the Value
checkbox to add it
to the table.

Select an Object (or
category).

[ o | conce

45

A Summary Table can be used on a front or back page. Similar to the Result
Table, it is divided into Objects and Values. Select the desired checkboxes to
create the table columns. Note that any Text Annotations created in the IR
Viewer are shown in the Objects list.
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@ e Add Document Properties

CENTER

Document Properties can be used to enter report information such as
Thermographer name, Company name, etc. When you send images from
FLIR Tools+ to a Word template a window will appear prompting you to enter
the values which will then automatically populate the report fields.

Thermography Inspection at:
ITC

Inspection Date:
[date]

Thermographer:
[thermographer]

46

Document Properties are a standard Word feature that is utilized by FLIR
Tools+ when creating Word reports. The purpose is to allow the user to enter
information about the report that would typically appear on the cover page.
Word fields are used to display this information. Note that this information is
not image-specific. Text Annotations should be used for image information.

The process of adding Document Properties varies depending on your Office
version.

6/29/2015

46




FLIR Tools+ User Guide

INFRARED
TRAINING
CENTER

Add Document Properties

(Label Configuration)

Tools+ to identify them.

First you must add this label and value:
FLIR_ReportPropertyPrefix = _

All FLIR Tools+ labels must begin with
the _ character.

For example, a label for “Customer”

should be entered this way: _Customer.

The Document Property labels must adhere to a certain format in order for FLIR

Name:

Type:
Value:

Properties:

Conditional (4 Levels).dotx Properties (AT
General | Summary | Statistics | Contents | Custom

Checked by

Client

Date completed

Department

Destination

Disposition

Text -

Link to content

Name Value T
FlirTempUnit 1 M
ElirDiett it 1 L
_Customer [customer] uE
_Address [sddress) T
_Contact Person [contact) T
_Phone [phone] T
_E-mail [e-mai] T
_Thermagrapher [thermogra... T~

« i »

o ] (e ]

47
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Add Document Properties

(Office 2007)

@Jd

To add Document

Properties click the Office
button, then Prepare,

;_.;J Print

P @EE UG ASEARP- =0

J View and edit document properties, such
as Title, Author, and Keywords.

Inspect Document
5/ Check the document for hidden metadata
or personal information.

(a] ) Encrypt Document
L8 increase the security of the document by
adding encryption.

%  Restrict Permission

@ Grant people access while restricting their

then Properties.

N
j Prepare

ability to edit, copy, and print.
S Add a Digital Signature

Ensure the integrity of the document by

jg'i Send

Publish

“
|' Close

adding an invisible digital signature

@ Mark as Final
S
Let readers know the document is final and
make it read-only.

] 3 Run Compatibility Checker
\Z Check for features not supported by earlier
versions of Word.

+) Word Options | | X Exit Word

48
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INFRARED
TRAINING
CENTER

Add Document Properties

(Office 2007)

& Document Properties ¥ ~

Location: C:\Documents and Settings\JGagnon\Applicat

Aul 1 Advanced Properties... E E

Comments:

\f

\

To create custom labels click
Document Properties, then
Advanced Properties.

ory: Status:

Jnmmll Properties

=)

Start by typing this label:
FLIR_ReportPropertyPrefix with a
value of _.
Click the Add button to add the new

label.

N

General | Summary [ Statistics | Contents | Custom

Now you can begin to enter other labels and
values to the list. Each label must begin
with the underscore character (_).

SLIR _ReportPropertyPre Add
" Gheiied by =
Chent
Date completed
| Department
Destination
Dispositon

Type: Text =

Link to content

Type
Text

49

Select Document Properties, then Advanced Properties. The General tab

shows some default properties, however you can easily create your own
properties from the Custom tab.
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Add Document Properties
(Office 2010)

Wl IR and Photo (with Summary).dot [Campatibility Mode] - Micrasoft Word SHECE X |
v e Pagelmowt  References Mailings  Redew  View  Devtloper  Addins  FUR Reporter 2]
I save R R
. . Information about IR and Photo (with Summary)
e C:\Documents and Settings\jgagnontApplication Data\Microsoft\Templates\IRUASON\NEW FO...
5 Open

Properties click the File

features are disabled to prevent problems when working with
s of Office. Converting this file will enable these features, but

tin layout changes. Properties ~

E;i-:l

- Permissions
T, Anyone can open, copy, and chan

Protect
ument -

hat it contains:
‘s name and related dates

To add Document

ed for accessibility issues by

Click Properties,
then Advanced

tab, Info.

Properties.

£l
Versions *

50

Properties.

Click the File tab and select Info. Click Properties, then Advanced

6/29/2015
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INFRARED
TRAINING
CENTER

Add Document Properties

(Office 2010)

Start by typing this label:

FLIR_ReportPropertyPrefix with a

value of _.

Click the Add button to add the new

label.

B

P
Documentl Properties

==

Now you can begin to enter other labels and
values to the list. Each label must begin
with the underscore character ().

Type:

Date completed
Department
Destination
Disposition

Text

General | Summary [ statistics | Contents | Custom

FLIR_ReportPropertyPre

—/ Checked by

v

Value:

] Link to content

Properties:

Name
AR

Value
FLIR

Type
Text

51
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Add Document Properties
(Office 2013)

Protect Document

To add Document
Properties click the File
tab, Info.

Cantrol what types of changes peaple can

make to this document.

Click Properties,
then Advanced
Properties.

52

Click the File tab and select Info. Click Properties, then Advanced

Properties.
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INFRARED
TRAINING
CENTER

Add Document Properties

(Office 2013)

Start by typing this label:
FLIR_ReportPropertyPrefix with a

value of _.

Click the Add button to add the new

label.

B

Document2 Properties 7 HEM|

Now you can begin to enter other labels and
values to the list. Each label must begin
with the underscore character ().

_—

Checked by
Client

Date completed
Department
Destination
Disposition

Text

General | Summary | Statistics | Contents | Custom

FLIR_ReportPropertyPre

~

v

v

I Value:

I [[JLink to content

Properties:

Name
FLIR

Value
FLIR

Type
Text

53
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@ Show Document Properties

Document Properties can be shown on the page using Word’s Field tool.

(W

Home Pagelayout  References  Mailings  Review  View  Developer  FLRTools+

L) Blank Page A Bookmark |3 Footer ~ "¢ Autolext

o Table | Picture Clip Shapes SmartArt Chart Screenshot Text =

= Page Break v Art . - {8) Cross-reference | () Page Number~ | gox~ | (e Document Property
Pages Tables llustrations Links Header & Footer

5 Document2 - Microsoft Word o

(&) Cover Page ~ 3 =8 Sy 8, Hyperlink {5 Header ~ A 3l Quick Parts ~ Signature Line ~ T Eq
) B Y 1= @l (™
B4 Ba U = (et ,

| Word 2007/2010 |

B H S O Conditional (4 Levels) [Compatibility Mode] - 2@ - 6
HOME DESIGN  PAGELAYOUT  REFERENCES  MAILINGS  REV) FLIR Tools+ Sign in
B CoverPage~  [™== 1 ) TSmartart ’ e TT Equation ~
[) Blank Page = = G 1/l Chart e
Table Pictures Online Shapes
%= Page Break 3 Pictures umber -
Page Tables lustrati & Footer

To insert a Word Field to

show Document Properties
Word 2013

click the Insert tab, then
Quick Parts, then Field.

54
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Show Document Properties

Please choose a field Field properties

The DocProperty category shows all default and custom Document Properties
in alphabetical order.

Field options

Categories: Property:
(am v _Address A
— Contact Person

Field names:

5’ BarCode A _E-mail

| Bibliography _Inspection Date

i’ BidiOutline _:hhone "

Citation ermographer . .

| Comments Custom fields will show here.
Compare .
CreateDate Select the desired field and
| Database Characters .

8 CharactersWithSpaces click OK.
Do(Pwe I Comments

TOTTTamaD Company

iEdlt'l'lme C v

|Eq

FileName

FileSize

Fill-in

lGoToBuﬁon

| Greetingline

Description:
Insert the value of the pro

Field Codes

Select
DocProperty.

Preserve formatting during updates

OK Cancel

55

DocProperty shows all default and custom Document Properties.
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INFRARED -
@zm’;wc Show Document Properties
Conditional (4 Levels) Properties 2 HE
‘ General | Summary | Statistics | Contents  Custom
INFRARED Infrared Training| = mow=
TRAINING . ) ot conpieted Dok
~ CENTER FLIR Systems, Inc e

The default value for the i
selected field is shown in the [P8raphy Report Prepared fc

template. This will be
replaced when the report is [Company]
created using FLIR Tools+.

-

N\

InspectiomQate: [Daté
Thermographer: [Thermograp er]|

Report Description:

56

When you insert the selected Document Property the default value is shown on
the template page. When the report is created you will have the opportunity to

replace this value with text that applies to the report you are creating.
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®

Save the Template

Account

Options

Save As

6 SkyDrive

i Computer

]
e

o= Add aPlace

&
j New

“»
= Open

Jd s

Save a copy of the document

h\‘i Save As

>

.
‘ju Print
{f Prepare

d Send

>

VEaE dU@ASRAE =0

v, j Word Document

Save the file as a Word Document.

F | Word Template
= Save the document as a template that can %

be used to format future documents.

@ ] Word 97-2003 Document

Save a copy of the document that is fully
compatible with Word 97-2003.

[; 5 OpenDocument Text
= Save the document in the Open Document

Format.

PDF or XPS
Q Publish a copy of the document as a PDF or
XPS file.

Select Save As from the File tab (Office
2010/2013) or Office button (Office 2007).

Formats

the Save As dialog box to select from
sible file types.

J [ ) Word Options |{ X Exit word |

57

Save the template as a standard Word Template file:

Office 2007: Click the Office button, Save As, Word Template.

Office 2010/2013: Click the File tab, Save As, and choose Word Template as
the document type.
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INFRARED
TRAINING
CENTER

Save the Template

3 Save As

« - 1 ¢ » Libraries » Documents »

Organize « New folder

2 Name

4 Libraries
Custom Office Templates

FLIR
FLIR Tools Templates

| Documents
@' Music

=) Pictures
H videos

& Homegroup

/% Computer

1 mmal Misle (030

v <

File name: | My Template
Save as type: | Word Template

Authors: Jason

[] Save Thumbnail

“ Hide Folders

o

Open Cancel

STRONG
RECOMMENDATION!
Create a new folder for
your custom FLIR Tools+
templates.

58

FLIR Tools+ allows you to set a user templates path. This means that you can
store custom template in a folder that is easy to find, instead of using the
default Microsoft folder for templates. Also, you'll be assured that the templates
are secured with your back-up software!

For example, you can create a new folder in My Documents called “FLIR Tools
Templates” and use this as your user templates path.
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INFRARED
TRAINING
CENTER

Save the Template

File name: | My Template]

Save as type:  Word Template

Authors: Jason Tags: Addatag

[] Save Thumbnail

] Save As q
(& - 4 « Doc.. » FLIR Tools Temp... 1
Organize » New folder
A Name psemoarn)  Save the template in
4 Libraries B Conditional (4 Levels) the new folder'
| Documents )
= B Conditional (5 Levels)
@' Music 21901 7
& Pictures G- IR and Photo 8/27/2013 9:27
B videor &7 IR Only 9/4/2013 5:14 PM ‘..;w:;-;:'“
% Homegroup Make sure Word
- Computer Template is selected
oaaniea ¥ <

as the file type and
click Save to save the
new template.

4 Hide Folders

Tools ~ Save Cancel

59

All your custom FLIR Tools+ templates can be saved in this new folder.
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TRAINING
CENTER

Set the User Template Folder

@ FLR Tools+

W Add 4 G) Import

! |

In FLIR Tools+ click
Options, then Report
and set the User
templates path to the
new templates folder.

Default document settings

When creating new reports, always use these settin
You can change these sattings tater in the report
Page size: Letter | v

Show all parameters

v | Extract digital camera photo from thermal \
when generating

| user express export templates path:

User legacy export templates path: ~ C:\Users\Jason... m

15items (0 selected)

60

In FLIR Tools+ you must set the user templates path so you can select
templates from the new folder:

Click Options, then Report.
Click Browse next to “user legacy export templates path” and select your new
template folder (in this case \My Documents\FLIR Tools Templates).
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INFRARED

@zsm@:rﬁ The Report Generation Process

» Import the images from the Infrared camera into their
appropriate folder.
» Modify the images if required such as:
* Level and Span
» Placement/modification of image measurement
tools
» Adjust object or measurement tool parameters
» Addition or modification of text annotations
+ Select the images to be used in the report.
+ Select the “Word” template to generate the report.
* Fill in the “Word Document Properties” if required.
+ Make any minor adjustments to the image if required.

61
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INFRARED

@zmw Import Images

+B@ Import images from camera

Click Import
ws' View images in library images from
camera.

4 Connect to live stream

3 Check for updates

62

If you connect a camera via USB while FLIR Tools is running a startup screen

will appear with links to common functions. Click the button to Import images
from camera.

View images in library will close the startup screen and show the image
library.

Connect to live stream will display a live image from compatible FLIR
cameras.

Check for updates will check for FLIR Tools updates. It can also check for
updates for certain FLIR USB cameras.
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it Analyze Images

Using the FLIR Tools Image Editor you can adjust the scale, color
palette and object parameters if needed. You can also measure
temperatures using a variety measurement tools and save
changes. See the FLIR Tools User Guide for a more detailed
explanation of the analysis options.

63
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it Create a Word Report

=S |

W Add 4 G) Import

Click on the folder path to
select all image groups in
the selected folder.

Or, use the CTRL or
SHIFT key to select more
than one group.

i

[}
i Y "

GR_0017

GR_00:
|
-
GR_0023

R_0021 v

|z~

19items (13 selected)

64

From the FLIR Tools library you can select the groups to send to the new
report. A quick and easy way to select everything in the folder is to click on the
path. This will automatically select everything in the current folder.

Another option is to use the SHIFT key to select everything in between two
groups (e.g.: click on GR_0001, hold down SHIFT, and click on GR_0011). Or,
hold down the CTRL key to select random groups.
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it B Create a Word Report

[-o & Jfat]

o Add 4 6) Import

W= W= W=

Building Pro Building Conditi\ N\ @4  Conditional  Electrical Pro  Electrical Pro IR and IR.dotx
20Rdotx  Standard 1xIR... Levels) W«  (with Load Cor... 2.dotx Template.dotx

E Word templates  (Expre t
E 7 =

Thermal ermal_ ~to  Thermal_xt
Large.dotx X Photo_x2.dotx

Click the down arrow, next to

Generate Report. [fyou set [ Click oha tempite
the user templates path under Dicicale 8 ew
P P Word report.

the Options menu you will see
the custom template(s).

19items (13 selected)

65

With the images selected, click the down arrow next to Generate Report. FLIR
Tools+ will show some sample Word templates and any custom templates that
have been created and saved to the user templates folder. Simply click on the
template you wish to use to begin creating the Word report.

Note: Be sure to set the user templates path from Options, Report, otherwise
the custom templates will not appear as a choice.

6/29/2015

65




FLIR Tools+ User Guide

INFRARED
TRAINING
CENTER

Create a Word Report

Enter the Document
Properties here and
click OK to finalize the
report.

O -
OME ~ INSERT ~ DESIGN  PAGELAYOUT  REFERENCES  MAILINGS
[Calibri 11 <A A Al B SN EE S
B I U-acx,x A-%-4- =

REVIEW

AaBbCcDc | AaBbccD« AaBbC AaBbCcl
7 Normal 2

TN T T

VIEW

[ o] o |

FUIR Tools+

TNoSpac.. Headi

ng 1

DESIGN

Headin

92

LAYOUT

& Fin

23 Rep|
3 Seld

Edit

66

Any Document Properties that were added to the template will appear in a
window before the final report is made. This allows you to enter the desired
values, which will then automatically populate the fields in the Word report.
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it i Create a Word Report

H - : Document! [Compatibility Mode] - Ward BLE TOOL 7@ - & X
HOME  INSERT  DESIGN  PAGELAYOUT  REFERENCES ~ MAILINGS  REVIEW  VIEW  FLRTook+ | DESIGN  LAYOUT Signin
ﬂ] u B IRProfile  [E Quick Insert (& Delete Page [ Report properties @ ¢
F{ Oigia |l IR Histogram (3 &l Duplicate Page e LR
Viewer Phato 4 IR Trending (2 Summary Table N .
mages and graphs Tables Document FUR Toolse -

[double-click to type
information here]

h’hermography Inspection Report For:

Infrared Training Center

The final report contains active, editable IR images. Text
annotations and other parameters can be edited, and you
can use the FLIR Tools+ tab to add tables, change units, add
and delete pages, and make other changes.

PAGE10F21 1051wWORDS [[®
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INFRARED

[EAINe Save the Report and Convert to PDF

SdE Save As BJ
T « My.. » FLIR Tools Temp... v & Search FLIR Tools Templates 0o

ERl| Oonize v Newfolder
-

@ oo
group

Click the File tab (or
Office button), then
Save As to save the
report as a Word
Document.

Y Documents A Name
o Music
&= Pictures

B videos

1% Computer
s Local Disk (C)
 CDDri ve (D Virt

LARAC e

File name: | New Report

Save as type: | Word Document
P V/ord Document
"% \Word Macro-Enabled Document
Wiord 97-2003 Document
Word Template

Word Macro-Enabled Templ te

I PDF
#5 Document
Hide Fold, Wi‘l’;‘wbpg
s =
Web Page, Fitered You can also save as PDF
:|R h Text Format
Plan Tex for sharing with others.
Word XML Document
Word 2003 XML Document
Strict Open XML Document
OpenDocument Ted
Works 6 - 9 Document

68

It is important to save the report as a Word document. The Word report
contains copies of all the images, allowing you to return to the report at any
time to make changes. Anyone with Word can view the document, but the IR
image cannot be manipulated without FLIR Tools+.

You can also save a PDF copy of the report, which is handy for sharing with
customers and colleagues.
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Thermal Tuning

(

Right-click to

-
.s

Temp Ris

-

Arl:max 76.0

Ref:temp 72.7

107.8] " change the color
palette.

Isotherm... |
—

90

Use the sliders to
adjust level and
span.

Right-click in the
blue area to auto-
span.

69

Since the infrared image is active in the Word document you can adjust the
level, span, and color palette, just like you can using the FLIR Tools editor.
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it Change Object Parameters

52.0 °C
/i

Open...
Save As...

v ShowIR Scale
Show Sketch
Zoom

5 |

Image Fusion...

[Reference

Rotate Right
Rotate Left

Image File Name: IR_0001,

Formulas...

Click Object Parameters to
change Emissivity, Reflected
temperature, etc.

Right-click and

click Settings.
[ ox ]

70

Right-click on the IR image and click Settings to change emissivity, reflected
temperature, and other Object Parameters.
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it Temperature Measurement

AR+ OO0OB / vADH - Q-@E

Temp. Riscly

Single-click on the IR image to
display the Measurement
Toolbar.

3

Ari:max 28
‘ From here you can add Spots,

Areas, Lines, DeltaT, and
Isotherms to the IR image. j

71

This image has a Spot Meter, Area Box, and DeltaT because these tools are
pre-defined in the template. You can click and drag any of these tools to re-
position them on the image. Tables linked to these tools will update
automatically.

If you single left-click on the image the Measurement Toolbar will appear.
This allows you to add new measurement tools if needed. The Word add-in
provides some additional tools that are not available in the FLIR Tools editor:
Polygon Area

Bendable Line

Arrow Marker

Image Fusion

Grid
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Edit Text Annotations

Ref:temp 72.7

Filename: IR_0005.jpg

Arl:max 76.0 80

115.0 °F

110

100

90

Date 5/6/2002 Image Description | -
Image Time 11:47:33 AM Location A, Room 123
Max Temperature 124.7 °F Equipment anel
Emissivity 0.95 Problem _~/ nection
Arl Max. Temperature | 76.0°F [ V tion | Repair
Ref Temperature 72.7°F
Temp Rise Value 3.4 DO NOT TYPE /

INTO THE

TABLE! J

Text Annotations are displayed in a Result Table that is linked to the IR image
If you type into the table everything
you type will be erased the next time the table refreshes. The next step

on the page. DO NOT

type into this table.

explains how to properly edit Text Annotations.
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CENTER

@mﬁ?ﬁz Edit Text Annotations

Click the
Notepad icon.

‘ | Ref:temp 72.7 |

Filename: IR_0005.jpg

Date [ s/e/2002

Image Time

E"a," Temperatul  Modify the value
Sl and click OK. The

Arl Max. Tempq X
RefTemperatur]  table will update

Temp Rise Valud automatically.

73

Text Annotations values must be edited by using the Notepad icon on the IR
image. The text shown in the table will update automatically.
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@zsm';ws Image Fusion

Rﬁz#ﬂoa/wA.pm.q.\&

Click on the Image
Fusion button to
create a fusion
image.

74

Image Fusion allows you to merge an IR image with a matching visual photo.
For fusion to work you must identify 3 reference points in the IR image and
visual photo. Thermal tuning can help tremendously in selecting the best
reference points. By adjusting the level and span, and by using a high-contrast
color palette, you can draw out parts of the image that are easy to see in the
photo but have a small thermal contrast in the IR image.

Click the Image Fusion button to begin the process of aligning the images.
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@zsm';ws Image Fusion

s

Py

Position the 3 markers so they are
referencing the same point on the
IR image and photo.

Open R Image... r—
Thermel MSX hee point2 | Reference Point 3
M Black and White
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A matching photo will automatically open if one exists in the source folder.
Otherwise click the Open Photo button to select the matching photo. It is not
necessary to use a visual photo from a FLIR camera, however if your camera
has this ability it is strongly recommended.

There are 3 reference points on each image. Click and drag on each

reference point until it is in approximately the same position on the IR image
and photo.
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it Qi Image Fusion

Use the Reference
Point buttons to
magnify each region to [ ==

make more precise | Reterencepointz |
adjustments. T

o [ o oo
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Click on each Reference Point button to magnify each region. This allows you
to more precisely position the markers.
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it Qi Image Fusion

Select the Fusion
Mode and click OK.

etrence Point 1 P s e ence oot 2o [ s Ressence Poiot 3
I Black and White

o [ o oo
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Select the desired Fusion Mode and click OK to blend the images.
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it Qi Image Fusion

| Interval R .. Al Blending
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This shows the same fused images in each Fusion mode. You can click on the
Fusion button on the Measurement Toolbar to change modes at any time.
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@ Image Fusion

Right-click and select
Save As to save the
fused image back into
your FLIR Tools

Show IR Scale ; :
| \\ ||brary.
Zoom

Save As...

Settings...

Image Fusion...

Rotate Right
Rotate Left

Formulas...

Fusion image in Word

Fusion image in FLIR Tools
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On the report page, you can right-click on the fused image and click Save As to
save the image to your FLIR Tools library. This allows to you edit the image
using FLIR Tools. The image mode buttons will appear just as if it was saved
from a camera with MSX, thermal fusion, or picture-in-picture.
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INFRARED .
TRAINING G d
@ CENTER rl

A+ 006 /7 vADH-A-@H

Click on the Grid
button to enable or
disable the image
grid.
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The Grid can be used as a way to calibrate the image based on the distance
away and the lens field-of-view, or by using the known length of a line.
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INFRARED -
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Set the grid size using the
distance away and lens FOV.

b ool D B b B ) Grid Size = number of

“units”:
1 foot or meter.

To set the grid size, type the
distance away from the
target and the lens FOV.

To configure the grid
size, right-click on
the IR image and click

Settings.
[ o] |
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To access the Grid Settings: right-click on the IR image, click Settings, then
click the Grid Settings tab.

The Grid Size is the number of “square units” for each grid box. For example, a
Grid Size of 1 would configure each grid box to be 1x1 feet or meters.

The Distance setting is the distance away from the target (in feet or meters).
The FOV is the lens field-of-view.
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Set the grid size using a line.

Draw a line on the
image at a known
length...

...and set the line
length in the Grid
Settings.
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You can also draw a line of a known length, and use this to calibrate the grid.
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A calibrated grid now
appears on the image.
If you click on each
box...

...they become
measurement areas
when the grid is

disabled.
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Once configured a calibrated grid will appear on the image, each box
represents an area of 1x1 units. If you click on the grid boxes they become
measurement areas once the grid is disabled.
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@ Express Reports

©® FURTooks+ [ ][ [mtsa]

o Add 4 6) Import

W= W= W=

Building Conditional 4  Conditional  Electrical Pro  Electrical Pro IR and IR.dotx
Standard 1xIR.... Levels)dotx (with Load Cor.. 2.dotx

- . -
Click the down arrow,
o to Th\u N

Template.dotx

ermal_Photo  Thermal_Photo  Thermal_xi
Topdotx  Top_Minidotx Photo_x2.dotx

>

‘aq

The Express
report templates
appear in this list.

next to Generate

19items (13 selected)
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Express report templates provide the user with the ability to create very large
reports, with potentially hundreds of images. This exceeds the limitations
imposed by the legacy templates.

To create an express report simply select some image groups from your image
library and click on the desired express report template.
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Express Reports

Tools\Templates\DocX

Express templates are located in this folder:
C:\Users\[user name]\AppData\Local\FLIR Systems\FLIR

Jason’s Thermography Report
for ITC

CUSTOMER / SITE: | [CUSTOMER / SITE]
ADDRESS: | [ADDRESS)
THERMOGRAPHY DATE: | [THERMOGRAPHY DATE]

THERMOGRAPHER: | [THERMOGRAPHER]

\

The logo and other

content on front and

back pages can be

customized. The IR

page content cannot
be changed.
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Certain aspects of the express templates can be customized, such as cover
and back pages. The IR page content cannot be edited.
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Express Reports

& kel B

1) Blank Page
Table | Picture

o Developer FUR Tools+
(8 Cover Page - ,_]i Select File, Save As | 4 Header - [Ag] @ auxrans-
— s K & Footer A wordart ~
to save your modified |.... | ... [

¥=) Page Break

express template.

v |4

J

Documents library
udes: 2 location:

5

4 Libraries
«| Documents

& Music
] Pictures {
B videos FUR FUR FU
X Bxpress  Templates
Templ:
1% Computer Smene

& Local Disk (C)

€ Netwark

[T Ay Express Temp
Save a5 type: | Word Template (*.dotx)

# Hide Folders

STRONG
RECOMMENDATION!
Create a new folder for
your custom FLIR Tools+
templates.
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The template can be saved to any folder as a new Word DOTX template. The

custom template path can be set in FLIR Tools.
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@ Express Reports

The express template
path can be set under
Options, Report.

always use these settings:
You can change these settings later in the report

Page size: Letter >

Show all parameters

v | Extract digital camera photo from thermal image (if availat
when generating
a Generate report v

gl Gt \ —
User express export templates path: N on\. Browsk. Word templates (Legacy export for FLIR Word r

Built-in legacy export templates path: VOl B s W _ — \\ - \\ -
User legacy export templates path: Browse > N c— —
¥ 4 :k -
)’ 1
0

=== Building Pro Building Conditional (4
2xIR.dotx Standard 1xR....  Levels).dotx

Word templates (Express export

1 My Express Photo Thermal
" Template.dotx Large.dotx Large.dotx

Once the path is set your custom
templates will become available
in the Express report list.

GR_0007

87

To set the custom report path, click Options, then Report in FLIR Tools. Click
Browse next to “User express export templates path” and point this to your
custom template folder.

Once the path is set your custom templates become available in the express
report template list.
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Express Reports

©) Generate report . v

Building Pro Building Conditional 4 Conditional
2dR.dotx  Standard 1xIR... Levelsi.dotx (with Load Cor...

Set as default report template

Create Rapid Report shortcut on Desktop [N

Right-click on a template to create a
Rapid Report Desktop Shortcut.

J

From Windows Explorer you can

drag and drop a group of images

onto the Rapid Report shortcut to
create a new report.

_/

L)@/ di « Taining » Images
oJ

{ Favorites
5 Recently Changed
Public
B Desktop
|8 Downloads
3 Recent Places

4 Libraries
%) Documents

& Music

______________
1% Computer
&, Local Disk (C)

€ Network

 FUIR Rapid Report

= 28 items selected
Show more details.

Organize v 31 Edit Shide show Print E-mail New|

» Home Survey

DC_0372jpg IR.0313,
IR.0323,jpg 1R_0325,jp)

i pw
R i
IR 0331jpg 1R_0346.jp)

.
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The Rapid Report option allows you to create a shortcut on your Desktop for

creating new reports. This allows you to drag and drop a group of images from
Windows Explorer onto the shortcut without needing to start FLIR Tools. Word
will automatically open when the new report is created.
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@ Support and Training

* For FLIR technical support, downloads and other
resources please visit hitp://support.flir.com

« For more information about training please visit
http://www.infraredtraining.com. Here you can find a
complete list of certification courses, on-demand
courses, webinars, and community forums.
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